Please note the Important Hints on a separate sheet.

Contents

1 Introduction 3

2 Basics 4
   2.1 Filter Circuits 4
   2.2 Planar Circuits 4
   2.3 Active Circuits 5
   2.4 Optimization 5
      2.4.1 Searching Algorithms 6

3 Stability of Amplifiers 8
   3.1 Stability Criteria 8
   3.2 Stability Circles 9
      3.2.1 Output Stability Circle 9
      3.2.2 Input Stability Circle 11

References 14

4 Questions and Problems on the Lab 15

5 Measuring Tasks 18
   5.1 Creation of work environment Workspace 18
   5.2 Filter Circuits 18
      5.2.1 Creation of a Schematic Page 18
      5.2.2 Simulation 19
      5.2.3 Presentation 19
      5.2.4 Butterworth LowPass Filter 20
   5.3 3dB-Hybrid Coupler 21
   5.4 Amplifier 24
   5.5 Amplifier Noise Figure 27
   5.6 Additional Task: Coupler In Momentum 30

A Parameters of the Microstrip Line 34

B Rogers 6010 Laminates 35

C Scattering Parameters of the Transistor CFY 66 36

D ADS TLines-Ideal Symbol Overview 37
   D.1 ADS TLines-Ideal MLIN Overview 37
   D.2 ADS TLines-Ideal MTEE Overview 38
   D.3 ADS TLines-Ideal MSUB Overview 39
1 Introduction

Circuit simulation in RF engineering is a very important task, since the design made by synthesis, only, never has the desired properties in a practical sense. Additionally, tuning is only possible in rare cases and a re-design should be avoided due to high costs. To minimize the effort for the circuit development, the designed circuit has to be analyzed in a first step using a simulation program. If this succeeds, the circuit can then be produced with lower risk.

Central subject of this lab is the use of ADS, one of the most popular CAD programs for analyzing (simulation), optimization, and layout producing of microwave circuits.

With the aid of ADS transmission line circuits as well as circuits consisting of lumped elements may be simulated. The properties of all elements between the nodes in a network are given generally as mathematical models. Otherwise the insertion of multiports, characterized by measured scattering parameters (e.g.) which may be part of a circuit to be analyzed is also possible. After entering the whole circuit the program computes the behaviour of the structure using partly very extensive matrix calculations. Additionally, algorithms for large-signal analysis (e.g. Harmonic Balance) are available.
2 Basics

Three typical RF circuits should be considered in this lab: filter, coupler, and amplifier. We have to distinguish between circuits made of lumped elements, which are used at frequencies up to a few GHz and those made of distributed elements used in RF applications.

The **bold** printed keywords in the text of each section should serve as an orientation. Every participant should be familiar with these terms and should be able to explain them.

### 2.1 Filter Circuits

Filters are one of the most important circuit types in the RF engineering. They are used, e.g. for separation of different transmission channels in communication engineering or for the selection of frequencies in the radiometry. Ideal filters block in a given frequency range, the **stopband**, totally, whereas the signals in the **passband** are transmitted without any attenuation and with frequency independent **group velocity**. The frequency range of the passband determines the filter type.

Filters are categorized in **lowpass**, **highpass**, **bandpass**, and **bandstop** filters. Real filters show finite **passband** and **stopband attenuation** $L_P$ and $L_S$, which characterize the filter behavior in the different frequency ranges. Common lowpass filter prototypes are the **Chebyshev lowpass filter** and the **Butterworth lowpass filter**, also referred to as **maximally flat magnitude lowpass filter**. These filter types have to be realized in this lab experiment and, thus, should be well known to every participant. Based on the lowpass prototypes, every other filter type can be generated using the frequency transformations **lowpass-to-highpass transformation** or **lowpass-to-bandpass/stop transformation**.

### 2.2 Planar Circuits

When considering transmission line circuits, generally ideal TEM transmission lines are assumed. In practice, these waveguides change their behavior drastically with increasing frequency and cannot be characterized with the transmission line theory anymore. Differences from the ideal behavior are caused by the influence of discontinuities (impedance steps, transmission line bifurcations etc.) or by the effect of dispersion. In ADS mathematical approximations for most of the common planar transmission line as well as discontinuity types are included. Exact numerical methods can be used in ADS but the calculations are very time consuming and therefore not standard used in an interactive CAD program.

As an example a 3dB-hybrid coupler is employed in this lab experiment. Basics on **planar circuits**, their realizations (**MIC** = Microwave Integrated Circuit, **MMIC** = Monolithic Microwave Integrated Circuit, **MIMIC** = Microwave/Millimeter Wave Monolithic Integrated Circuit), and their properties such as **dispersion**, **effective relative permittivity**, **losses**, or **equivalent circuits**, as well as structure and properties of a **3dB-hybrid coupler** are treated in the lecture, exercise and this lab course and were assumed as known here.
2.3 Active Circuits

Active devices like amplifiers, mixers, and oscillators are very important components in RF engineering. Therefore, ADS is able to deal with these kinds of nonlinear circuits using the Harmonic Balance and other methods for analyzing. This lab experiment deals with linear amplifier circuits. The used transistor is utilized in a common-source circuit with complex load. First, the circuit should be tested for stability (see next chapter) and achievable gain based on the reflection and transmission coefficient. Then, to increase gain and stability, power matching at the input and output side should be performed. This is done using matching networks consisting of serial transmission lines with characteristic impedance 50Ω, \( \lambda/4 \) transformers with short circuit or open loop as line termination. To design these networks and obtain the line parameters, the Smith Chart is used. Required techniques are detailed in the exercise and are assumed to be known.

2.4 Optimization

A very effective tool for improving of circuit properties may be optimizing routines which are implemented in most of the CAD programs. Very important is the choice of starting values and the proper definition of a suitable error function.

All optimizing algorithms follow—after implementation of the circuit under consideration—the one basic principle:

1) One or more of the circuit components will be defined as optimization parameters, whose values are in a given range but not fixed, only starting values for this parameters have to be chosen.

2) The frequency range to be used in the error function is defined.

3) Optimization equations and goals have to be given:

   Example: Design of a four-port 3dB coupler; the power incident at port 1 should be divided to equal parts to port 2 and port 3. The error function of the optimization goal could be:

   a) \( F_1 = |S_{21}| - |S_{31}| \)

   b) \( F_2 = |S_{11}| \)

   The total error function, zero in the ideal case, is finally:

   \[
   F = g_1 F_1 + g_2 F_2 ,
   \]

   \( g_1 \) and \( g_2 \) are weighting functions of the particular optimization goals.

4) The circuit is analyzed, the error function is calculated which is an extent of the difference between the goal and the real value of the optimization equation.

5) According to a given search algorithm the optimization parameters will be changed.

6) Both preceding steps have to be repeated until either the error function falls below a given limit value or the number of loops exceeds a maximal value.
2.4.1 Searching Algorithms

![Example of an error function dependant of two variables.](image)

![Course of a gradient optimizer.](image)

There are an arbitrary number of algorithms to determine the minimum of a function \( f \), two of these should be presented briefly, which are part of ADS. In Fig. 1 a very simple error function dependant of two variables is shown. Real problems have more complex error functions and cannot be displayed properly by reason of the N dimensionality.

**Gradient algorithm** Applying the gradient algorithm, which is the Newton’s method in the one-dimensional case, the derivation of the function \( f \) is needed. The course of the function’s argument follows always in the direction of the steepest slope down to a minimum, where all derivations are positive or zero.

The disadvantage of the gradient method is the fact, that only local minima may be found, but it is not sure, that this local minimum is the global one in the range of the parameter values. Thus, this method is suited in the case very good starting values are known.

**Evolution algorithm** Base of the evolution algorithm is the biological principle of *mutation* and *selection*. Beginning with the starting vector, all numbers are changed by random (mutation). If this leads to a greater number of the error function (failure), the mutation will be discarded and a new mutation starts. In the case of success (smaller number of the error function’s value) the function \( f \) will be scanned in this new direction of the last mutation. If this leads again to worse values, the statistical process of mutation will be started again, see Fig. 2.
Using evolution and gradient optimizer alternating is very common in the practical use of optimizing strategies.

- Optimizing algorithms
- Goals and error functions
3 Stability of Amplifiers

3.1 Stability Criteria

The most important point when designing an amplifier is the guarantee of stability. The two-port is an active element which can function as an amplifier or as an oscillator, depending on the other circuit elements it is connected to. For an amplifier design, the oscillating function is an undesired, unstable operation.

Figure 4 depicts a general two-port with source and load, whose stability needs to be investigated.

![Diagram](image)

Fig. 4: Wired two-port for stability analysis.

The following is valid also for any arbitrary two-port when the focus is on the two-port as an amplifying element. One speaks of unconditional stability if for all source and load reflection coefficients, \(|r_G|<1, |r_L|<1\), the two-port is stable.

A two-port is stable, when the following conditions are fulfilled:

\[
\begin{align*}
|r_1| < 1, \\
|r_2| < 1, \\
|r_G| < 1, \\
|r_L| < 1, \\
|s_{11}| < 1, \\
|s_{22}| < 1.
\end{align*}
\]

To be certified as unconditionally stable, the following criteria must be fulfilled for all possible passive source and load impedances:

\[
\begin{align*}
|r_1| < 1 \quad &\forall \quad |r_L| < 1, \\
|r_2| < 1 \quad &\forall \quad |r_G| < 1, \\
|s_{11}| < 1, \\
|s_{22}| < 1.
\end{align*}
\]

An obvious disadvantage of these criteria is, that there are infinite conditions which need to be satisfied.

In addition to the given criteria, there is also a graphical solution, in which is shown the stability circles so arranged, that for both the input and output, the Smith diagrams show an unconditionally stable behavior. More details will be discussed in the following chapter.
For all stability criteria it is also necessary that all scattering parameters and reflection coefficients are normalized to the same characteristic impedance.

Much more manageable conditions for unconditional stability are the following:

\[ K = \frac{1 - |s_{11}|^2 - |s_{22}|^2 + \left| \det\left( \begin{bmatrix} s_{11} & s_{12} \\ s_{21} & s_{22} \end{bmatrix} \right) \right|^2}{2 |s_{12}| |s_{21}|} > 1 , \]  

this is the (Rollett) stability factor, the derivation of which can be found on page 12.

Additionally, the following must also be fulfilled:

\[ |s_{12}| |s_{21}| < 1 - |s_{11}|^2 , \]  
\[ |s_{21}| < 1 - |s_{22}|^2 , \]  
\[ |s_{11}| < 1 , \]  
\[ |s_{22}| < 1 . \]

When \( K < 1 \), it follows that the two-port is not stable for all values from \( |Z_G| < 1 \) and \( |Z_L| < 1 \).

### 3.2 Stability Circles

This paragraph discusses the derivation of the stability circle, which marks the intersection point between the stable and the unstable regions in the Smith chart for all source and load impedances.

#### 3.2.1 Output Stability Circle

The input reflection coefficient \( r_1 \) when port 2 is connected to the load \( r_L \) is

\[ r_1 = s_{11} + \frac{s_{21} s_{12} r_L}{1 - s_{22} r_L} = \frac{s_{11} - r_L \det\left( \begin{bmatrix} s_{11} & s_{12} \\ s_{21} & s_{22} \end{bmatrix} \right)}{1 - s_{22} r_L} , \]

with \( \det\left( \begin{bmatrix} s_{11} & s_{12} \\ s_{21} & s_{22} \end{bmatrix} \right) = s_{11} s_{22} - s_{12} s_{21} \).

The transistor is stable, when the following is valid

\[ |r_1| \leq 1 \quad \forall \quad |r_L| < 1 . \]

The boundary case \( |r_1| = 1 \) is a circle in the \( r_1 \) plane and this circle becomes again a circle in the \( r_L \) plane after the conformal mapping \[ (16) \]:

\[ |r_1|^2 = 1 : \quad |s_{11} - r_L \det\left( \begin{bmatrix} s_{11} & s_{12} \\ s_{21} & s_{22} \end{bmatrix} \right)| = |1 - s_{22} r_L| . \]

The evaluation and the comparison with the circle equation with the shifted center point (that is with \( |Z_L - m|^2 = R^2 \)) gives for the center point \( m_1 \) and the radius \( R_1 \) of the output stability circle

\[ m_1 = \frac{s_{22}^* - s_{11} \det\left( \begin{bmatrix} s_{11} & s_{12} \\ s_{21} & s_{22} \end{bmatrix} \right)^*}{|s_{22}|^2 - |\det\left( \begin{bmatrix} s_{11} & s_{12} \\ s_{21} & s_{22} \end{bmatrix} \right)|^2} , \]

\[ R_1 = \frac{|s_{12}| |s_{21}|}{|s_{22}|^2 - |\det\left( \begin{bmatrix} s_{11} & s_{12} \\ s_{21} & s_{22} \end{bmatrix} \right)|^2} . \]
Derivation of the output stability circle:

\[
\Delta \equiv \det(\frac{M^2}{\lambda})
\]
\[
\xi_1 = \frac{\xi_{11} - \xi_L \Delta}{1 - \xi_{22} \xi_L}
\]
\[
\xi_1 \xi_1^* = \frac{(\xi_{11} - \xi_L \Delta) (\xi_{11}^* - \xi_L \Delta^*)}{(1 - \xi_{22} \xi_L) (1 - \xi_{22} \xi_L)}
\]

\[
\Rightarrow (\xi_{11} - \xi_L \Delta) (\xi_{11}^* - \xi_L \Delta^*) = (1 - \xi_{22} \xi_L) (1 - \xi_{22} \xi_L)
\]
\[
|\xi_{11}|^2 - \xi_L \Delta \xi_{11}^* - \xi_L \Delta^* \xi_{11} + |\xi_L|^2 |\Delta|^2 = 1 - \xi_{22} \xi_L - \xi_{22} \xi_L^* + |\xi_{22}|^2 |\xi_L|^2
\]
\[
|\xi_L|^2 - \xi_L \Delta m^* - \xi_L^* m + |m|^2 = \frac{1 - |\xi_{11}|^2}{|\Delta|^2} - \frac{|\xi_{22}|^2}{|\Delta|^2} + |m|^2
\]

This is a circle equation:

\[
(|\xi_L| - m)(|\xi_L^*| - m^*) = |\xi_L|^2 - m^2 = \frac{1 - |\xi_{11}|^2}{|\Delta|^2 - |\xi_{22}|^2} \pm \frac{\sqrt{\frac{|m|^2}{\Delta} \gamma_{22}^2}}{R^2}
\]

\[
R^2 = \frac{(1 - |\xi_{11}|^2)(|\Delta|^2 - |\xi_{22}|^2) + |\Delta|^2 |\xi_{11}|^2 + |\xi_{22}|^2 - \xi_{11}^* \xi_{22} \Delta - \xi_{11} \xi_{22} \Delta^*}{|\Delta|^2 - |\xi_{22}|^2}^2
\]

\[
R^2 = \frac{|\Delta|^2 - |\Delta|^2 - |\xi_{11}|^2 + |\xi_{22}|^2 + |\xi_{22}|^2 |\Delta|^2 + |\xi_{22}|^2 - \xi_{11} \xi_{22} \Delta - \xi_{11}^* \xi_{22} \Delta^*}{|\Delta|^2 - |\xi_{22}|^2}^2
\]

\[
R^2 = \frac{(\Delta - \xi_{11} \xi_{22})(\Delta^* - \xi_{11}^* \xi_{22}^*)}{|\Delta|^2 - |\xi_{22}|^2}^2
\]

\[
R = \frac{|\Delta - \xi_{11} \xi_{22}|}{|\Delta|^2 - |\xi_{22}|^2}
\]

with \(|a b| = |a| |b| : R = \frac{|\xi_{22}|}{|\Delta|^2 - |\xi_{22}|^2}

Fig. 5 shows a typical stability circle \((m_1, R_1)\) in the Smith chart in the \(\xi_L\) plane.

Fig. 5: Output stability circle in the \(\xi_L\)-plane.

As already mentioned, this circle represents the boundary between stability and instability, that is oscillating behavior, of the transistor circuit. It cannot yet be said if the transistor
3 Stability of Amplifiers

is stable inside or outside the circle. To make a decision about this, the necessary stability investigation needs to be made for a point that does not lie on the circle.

The stability of the center point of the Smith chart in the $\mathcal{Z}_L$ plane is the easiest to determine. At this point is $\mathcal{Z}_L = 0$ and the input reflection coefficient is no longer dependent on port 2, because this is now closed and the following is then valid: $\mathcal{Z}_1 = \mathcal{Z}_{11}$. Provided $|\mathcal{Z}_{11}| < 1$, the amplifier and its circuit elements are stable at this point. For the above example, the transistor is stable outside the stability circle, however only as far as what concerns the output stability circle.

3.2.2 Input Stability Circle

Similar conditions and equations are valid for the input stability circle:

\[
\mathcal{Z}_2 = \mathcal{Z}_{22} + \frac{\mathcal{Z}_{13} \mathcal{Z}_{21} \mathcal{Z}_G}{1 - \mathcal{Z}_{11} \mathcal{Z}_G} = \frac{\mathcal{Z}_{22} - \mathcal{Z}_G \det(\mathcal{Z}_G)}{1 - \mathcal{Z}_{11} \mathcal{Z}_G},
\]

\[
|\mathcal{Z}_2| \leq 1 \quad \forall \quad |\mathcal{Z}_G| < 1,
\]

\[
|\mathcal{Z}_2| = 1 \quad \text{Circle in the } \mathcal{Z}_G \text{ plane},
\]

\[
|\mathcal{Z}_2| = 1 : \quad |\mathcal{Z}_{22} - \mathcal{Z}_G \det(\mathcal{Z}_G)| = |1 - \mathcal{Z}_{11} \mathcal{Z}_G|,
\]

\[
|\mathcal{Z}_G - \mathcal{m}|^2 = R^2,
\]

\[
m = \frac{s_{11} - s_{22} \det(\mathcal{Z}_G) \mathcal{Z}_G}{|s_{11}|^2 - |\det(\mathcal{Z}_G)|^2},
\]

\[
R^2 = \frac{|s_{21}| |s_{12}|}{|s_{11}|^2 - |\det(\mathcal{Z}_G)|^2}.
\]

The pictures in Fig. 6 show all four fundamentally different constellations of the stability circles as well as the stable regions, shaded gray with the prerequisite, that $|\mathcal{Z}_{11}| < 1$ and $|\mathcal{Z}_{22}| < 1$ are valid.

![Stability Circles](image)

**Fig. 6:** All principally different stability circles; the stable region is marked gray.

The transistor is unconditionally stable in cases I and IV. The unconditional stability in these two cases can be mathematically so expressed:

\[
I: \quad |m| > R + 1,
\]

Lab course RF Engineering 3: CAD (Linear Circuits)
The same condition results from both the equations

\[ |m| - R > 1. \]  

When one applies the quantities \( m_1 \) and \( R_1 \) in (31) and rearranges the equation, the following conditions result:

\[ K \equiv \frac{1 - |s_{11}|^2 - |s_{21}|^2 + \det \left( \begin{array}{c} X \end{array} \right)^2}{2 |s_{12}| |s_{21}|} > 1, \]  

where \( K \) is labeled as the \textit{stability factor} or \textit{Rollett stability factor}, and

\[ |s_{12} s_{21}| < 1 - |s_{11}|^2. \]  

Application of the quantities \( m_2 \) and \( R_2 \) in (31) and subsequent rearrangement results in similar conditions:

\[ \text{(32), } \quad |s_{22}| < 1 \quad |s_{12} s_{21}| < 1 - |s_{22}|^2. \]  

Since the stability factor is equally valid for both ports, it can thus be said that just one stability circle shows that the circuit in respect to a port is unconditionally stable and the same statement is valid also for the other port.

---

**Derivation of the stability factor:**

\[ \left| \frac{s_{22} - s_{11} \Delta^*}{\Delta^2} - \frac{\Delta}{|s_{22}|^2 - |\Delta|^2} \right| > 1 \]

\[ |s_{22} - s_{11} \Delta^*| - |s_{12}||s_{21}| > |s_{22}|^2 - |\Delta|^2 \]

**Squaring:**

\[ \left( \frac{s_{22} - s_{11} \Delta^*}{\Delta^2} \right) \left( s_{22} - s_{11} \Delta^* \right) > \left( \frac{|s_{22}|^2 - |\Delta|^2 + |s_{12}||s_{21}|}{\Delta} \right)^2 \]

\[ L = |s_{22}|^2 - s_{11}s_{22} \Delta^* - s_{11}s_{22} \Delta + |s_{11}|^2 |\Delta|^2 \]

**Expanding:**

\[ L = |s_{22}|^2 - s_{11}s_{22}(s_{11}s_{22} - s_{22}s_{21}) - s_{11}s_{22}(s_{11}s_{22} - s_{22}s_{21}) + |s_{11}|^2 |\Delta|^2 \]

\[ L = |s_{22}|^2 - s_{11}^2 |s_{22}|^2 + s_{11}s_{22}s_{21}s_{22} - s_{11}|s_{22}|^2 + s_{11}s_{22}s_{21}s_{22} + |s_{11}|^2 |\Delta|^2 \]

\[ |\Delta|^2 = \left( s_{11}s_{22} - s_{22}s_{21} \right) \left( s_{11}s_{22} - s_{22}s_{21} \right) \]

\[ |\Delta|^2 = |s_{11}|^2 |s_{22}|^2 + |s_{22}|^2 |s_{21}|^2 - s_{11}s_{22}s_{21}s_{22} - s_{11}s_{22}s_{21} - s_{11}s_{22}s_{21} \]

\[ |s_{12}|^2 |s_{21}|^2 - |\Delta|^2 = -|s_{21}|^2 |s_{22}|^2 + s_{11}s_{22}s_{21}s_{22} + s_{11}s_{22}s_{21}s_{22} = \chi \]

\[ \implies L = |s_{22}|^2 - |s_{11}|^2 |s_{22}|^2 + |s_{22}|^2 |\Delta|^2 - |\Delta|^2 + |s_{12}|^2 |s_{21}|^2 \]

\[ L = (|s_{22}|^2 - |\Delta|^2)(1 - |s_{11}|^2) + |s_{12}|^2 |s_{21}|^2 \]
Expanding:

\[
R = (|s_{22}|^2 - |\Delta|^2)^2 + |s_{12}|^2 |s_{21}|^2 + 2 |s_{12}| |s_{21}| (|s_{22}|^2 - |\Delta|^2) \\
L > R \\
(|s_{22}|^2 - |\Delta|^2)(1 - |s_{11}|^2) + |s_{11}|^2 |s_{21}|^2 > (|s_{22}|^2 - |\Delta|^2)(|s_{22}|^2 - |\Delta|^2 + 2 |s_{12}| |s_{21}|) + |s_{12}|^2 |s_{21}|^2 \\
1 - |s_{11}|^2 > |s_{22}|^2 - |\Delta|^2 + 2 |s_{12}| |s_{21}| \\
1 - |s_{11}|^2 - |s_{22}|^2 + |\Delta|^2 > 2 |s_{12}| |s_{21}| \\
K = \frac{1 - |s_{11}|^2 - |s_{22}|^2 + |\Delta|^2}{2 |s_{12}| |s_{21}|} > 1
\]

The stability circles are functions of frequency. Specially for low frequencies, at which usually amplification is high, that is \(|s_{21}|\) is large, the stability is critical and it must be catered for by special support circuitry at the input and output of the transistor so that the stability of the circuit can be guaranteed.

Stability investigations must be carried out for all frequencies at which the amplifier could be used. The highest operating frequency of a transistor is given by the extrapolated **transit frequency** \(f_T\), at which the amplification, that is the gain, with a short-circuited output is still \(G=1\). However with increasing frequency, the probability that the transistor is unstable drops because of the decreasing amplification/gain.
References


4 Questions and Problems on the Lab

Note:
The following preparation questions are required for this lab course.

A lossless lowpass filter should be designed, source impedance as well as load impedance are 50 Ω. The maximal passband attenuation below 1 GHz should be 0.05 dB, 30 dB the minimal stopband attenuation above 2 GHz. In a first row, a Chebyshev filter has to be designed.

Problem 1: Verify the need of a lowpass filter of 5th order to fulfill the given demands.

Problem 2: Determine the necessary circuit elements by using a minimal number of capacitors.

Problem 3: Which asymptotic slope of the attenuation curve in dB per decade and dB per octave do you expect?

The perturbation of the group delay of the Chebyshev filter is too high, therefore a Butterworth filter of the same order should be designed. The minimal stopband attenuation must not exceed the given number.

Problem 4: Which maximal passband attenuation has to be allowed at the least (precision 1 dB)?

Problem 5: Determine the necessary circuit elements.

A 3 dB/90° hybrid coupler for the operation frequency 5 GHz in a 50 Ω system should be designed. As substrate material RT Duroid 6010 is available with thickness h=0.635 mm and the relative dielectric constant ε_r=10.8. There is further information in the attachment B, page 35.

Problem 6: Write down the scattering matrix of an ideal 3 dB coupler.

Problem 7: Make a drawing of the coupler and draw in the crucial geometrical parameters as functions of Z_0 and λ, resp. What are the characteristic properties of this coupler?

Problem 8: Determine the necessary parameters for the realization on the given substrate by using appendix A, page 34. Please note that the effective dielectric constant depends on the characteristic impedance, i.e. the line width.

The transistor CFY 66 of the company Siemens (S-parameter may be depicted from Appendix C) should be used at 10 GHz as output stage of a transmitting antenna (Load) according to Fig. 7. The RF source has the inner impedance of 50 Ω, the antenna the input impedance (200 + j150) Ω.

Problem 9: Explain the term “stability”.

Problem 10: What is the meaning of the statement “the transistor oscillates”?

Problem 11: Write down the condition for oscillation of two connected components.

Problem 12: Check out if the transistor is unconditional stable at the operation frequency.

Problem 13: Determine the input and output stability circle at the operation frequency.
Problem 14: Sketch both stability circles into a handmade Smith Chart and mark the stable regions.

The amplifier should be power matched at the input as well as at the output simultaneously. The reflection coefficients seen into the wired amplifier two port should be replaced by the input reflection coefficients of the amplifier itself, i.e. the amplifier should be assumed as unilateral, ($\tilde{s}_{12} \approx 0$). This results in $\Gamma_1 \approx \tilde{s}_{11}$ and $\Gamma_2 \approx \tilde{s}_{22}$. For matching purpose circuits $M_1$ and $M_2$ are to be inserted as shown in Fig. 8. $M_1$ consists of two serial transmission lines, line 1 has the given characteristic impedance 50 $\Omega$ and line 2 is a $\lambda/4$ transformer with up to now unknown characteristic impedance. $M_2$ consists of a serial transmission line and a parallel short-circuited stub line, both having the characteristic impedance 50 $\Omega$.

Fig. 7: Principle equivalent circuit of the amplifier.

Fig. 8: Principle equivalent circuit of the matched amplifier.
Problem 15: Determine the necessary physical line length $l_1$, electrical line length $\phi_1$, and characteristic impedance $Z_2$, resp. by using the Smith Chart.

Problem 16: Determine again with the aid of the Smith Chart both line lengths $l_3$ and $l_4$ as well as both electrical line lengths $\phi_3$ and $\phi_4$ of $M_2$. 
5 Measuring Tasks

ADS is an interactive CAD program with a graphical user interface (GUI) which is controlled exclusively by mouse driven menus and by Hot-Keys. There is further information in the attachment E, page 40. ADS offers mostly more than one way to perform an operation, which results in a complex handling of the program.

The following statements relating to ADS 2015.01.

- Pull-down or pop-up menu commands will be denoted as Component Palette List > Simulation-LSSP > P2D.
- Menu Buttons will be shown in a frame, but the function may be found in an appropriate choice menu, too.
- ADS items look like Layout.
- Input of the user appear like → Filter. Important Hot-Keys which may lead to a considerable acceleration are shown in appendix H.

Important: Read and understand what when where how to do!

5.1 Creation of work environment Workspace

Start ADS (with the command → ads) and create a new Workspace. In the first window confirm the Next-Button, then chose a name of your workspace in the second window (e.g. group1_wrk, caution, the name have to end on _wrk!). In the third Window you have to uncheck the library DSP and to check the library S_Parameter_vendor_kit. (Path: /soft/nonpd/ads/ads/oalibs/componentLib/S_Parameter_vendor_kit). Confirm the fourth Window with the Next-Button. In the fifth window the millimeter resolution must be chosen (second from top). Finally the sixth Window shows an overview of the adjusted options. Press Finish to create your workspace.

5.2 Filter Circuits

First you have to assemble the Chebyshev filter, whereupon you will learn the main three steps of circuit simulations.

5.2.1 Creation of a Schematic Page

- Create a new Schematic-file. In the Window New Schematic enter as cell name → ChebFilter and press the OK-button.
- Lumped components are contained in the list Component Palette List > Lumped-Components. Insert the lumped elements inductances L and capacitors C. The Resistors and the sources are not required, yet. The components may be rotated with Ctrl-R or by using the Rotate button in the Toolbar border.
- The components may be connected by using Insert Wire (red line) or the combination Ctrl-W.
5 Measuring Tasks

- To change the default values of the components click once on the value or double click on the component. Fill in your solution from the preparation question.
- Then, input and output of the filter are connected with an S-parameter port. These ports are used to feed the filter and to start the simulation. Watch out for the block numbering since these equal the S-parameter numbering $s_{ij} = S(i,j)$.

Component Palette List > Simulation-S_Param > Term
- Connect the lower port connectors and the capacitors to ground: Insert > Ground or by using the Insert GROUND button in the Toolbar border.

5.2.2 Simulation

ADS offers different simulation procedures. You should perform the most common S-parameter simulation. For this purpose, analysis components have to be inserted in the Schematic-Page:

- Component Palette List > Simulation-S_Param > SP to perform an S-parameter simulation. Here, you can set the desired frequency range. Set the lower limit to 0 GHz and the upper limit to $f_S + 1$ GHz. A frequency step size of 0.01 GHz is sufficient.
- Save the current state of the finished page again with File > Save.
- Start the simulation with Simulate > Simulate, F7 or with the Simulate button. Another windows open to display the messages concerning the simulation and additionally an empty data display window.

5.2.3 Presentation

- If the simulation was successful, the simulated data can be displayed in the initially empty data display window. This window opens usually automatically, otherwise use: Window > New Data Display.
- In the Data Display Window the data can be displayed in different formats (Cartesian, polar, Smith Chart, simple numbers,...). The different formats can be selected by clicking on the left border and place it in the middle of the window. By default, the data is plotted over the simulated frequency range.

First, the transmission and reflection properties of the filter have to be determined. Which S-parameters of the two ports have to be examined, if the input port is port 1?

- Plot these S-Parameters in a Rectangular Plot. To do so, choose the required parameter(s) (to select more than one press and hold Ctrl) and add them to the list by pressing the >ADD>> button. In the next window you must specify what kind of data should be displayed (amplitude, phase, linear or dB,...). Please select dB, the options may be changed afterwards.

The scale factor of the plot may be changed by double-click on the plot. Marker Marker > New may be added as well. There is further information in the attachment E. To get
values of the plotted curve you may either set a marker or place the cursor above the desired point.

Make a draft of the filter plot:

What characteristic properties of the filter are observable? Does the filter show the expected behavior?

- Save the window using a suitable name. Don’t close the window, it is required later.

5.2.4 Butterworth LowPass Filter

The behavior of the Chebyshev and the Butterworth lowpass filters should now be compared.

- Switch back to the Schematic Page of the Chebyshev lowpass filter. To avoid building the filter once more, save **Schematic Page** using a new name (e.g. PotFilter): **File > Save As → PotFilter**.
- Change the values of the components according to your pre-calculated data and start a new simulation.
- Display the simulated data in a new **Data Window**.

What characteristic properties of the filter are observable? What differences to the Chebyshev lowpass filter are observable?

Make a draft of the filter plot:
5.3 3 dB-Hybrid Coupler

Now the 3 dB-hybrid coupler from the preparation section should be designed. Hereby, in a first step you have to build up the coupler structure in a Sub-Circuit using microstrip lines. This self made component may be placed, simulated, and optimized in a superior circuit. The advantage of such Sub-Circuits is that they are reusable - as known from functions in programming languages:

- Create a new cell named → Coupler_1. The required microstrip line components are included in the library Component Palette List > T-Lines-Microstrip > MLIN. To build up the rectangular coupler, the components MLIN, for transmission lines, and MTEE, for T-junctions, are required. You find further information in attachment D.
  Hint: insert some space between the components!
- Another transmission lines MLIN have to be connected to the free parts of the 4 T-junctions, respectively, because the pins cannot be connected directly to the T-junctions.
- Each of the four connector lines of the coupler have to be terminated by a Pin. Connect no S-parameter ports yet!
- Lengths and widths of the transmission lines of the sub-circuit should be modifiable later. Thus, instead of inserting values, variables are assigned to the component parameters (like w0, l0, w1, l1, etc.). The unit mm must be preserved! Consider which lines have the same properties, respectively, which may be assigned the same variables because of geometrical reasons. Assign the same variables to identical lines for length, respectively, width. The connector lines are 50 Ω lines with length 5 mm and require no variables. T-Junctions only have a width. The width of the connection parts must fit to the particular width of the adjacent transmission lines. The order of numbering can be looked up in attachment D or the manual of the component.

- Save all windows by using a suitable name and close the all filter windows.
5 Measuring Tasks

- The variables have to be visible from outside. To achieve this, go to **File > Design/Parameters...** Select the tab **Cell Parameters**. Here, the variable names and their default values (no units!) from the preparation questions can be entered and added by using the **Add** button.

- Save and close the file.

- For the simulation, the data of the used substrate has to be inserted: **Component Palette List > T-Lines-Microstrip > MSUB.** Insert now substrate height \( H = 0.635 \text{ mm} \), relative dielectric constant \( \varepsilon_r = 10.8 \), and the metallization thickness \( T = 17 \mu \text{m} \).

- Now, a symbol has to be assigned to the finished **Sub-Circuit** to utilize the created component in other circuits: Using the automatic symbol creation, the pin assignment of the **Schematic**-Window will be transferred in the **Symbol**-Window with **Window > Symbol** and confirm two times the **OK**-Button. The symbol window with the assigned symbol opens. Save and close the symbol window.

The new created symbol should now first be analyzed in a simulation:

- Create a new cell named → **Coupler_2**. The self made coupler can now be inserted by switching to **Insert > Component > Component Library > Workspace Libraries**. To insert your **Coupler_1** simply Drag-&-Drop or double click the coupler and switch back to the schematic window.

- Insert **S-Parameter Terms** at each port and connect these with ground. Don’t forget to save the circuit!

- Insert an S-parameter simulation component:

  **Component Palette List > Simulation-S_Param > S P.**

  Set the simulation range to 4 GHz to 6 GHz at a step size of 0.01 GHz and start the simulation.

  Plot the reflection and transmission behavior with respect to port 1 in a joint plot. Let your supervisor check your results. If changes of the coupler design are necessary, they have to be done in the file **Coupler_1**. The file has to be closed and opened again. If the coupler is working correctly, make a sketch of the plot:
At which frequency does the coupler work? Is the behavior ideal and is the aimed operating point achieved? What is the attenuation of $S(1,1)$ and $S(2,1)$ at 5 GHz?

What reasons may lead to this result?

Very probably the results are not very good, therefore an optimization procedure is used to improve the scattering parameters. It should be tried to ensure a good matching at the operation frequency and a low attenuation difference between the two pass bands. Optimization procedures in a CAD program work always in the same way: The circuit elements will be given in a range and not by fixed values and the program needs one or more Goals. The program simulates the circuit by taking in the first attempt the starting values. Running the optimization algorithm, the program tries to get better results according to the error function:

- Save Coupler_2 using a new name (e.g. → Coupler_3).
- As only the center frequency should be optimized, insert a second S-parameter simulation:
  Component Palette List > Simulation-S_Param > S P
  and choose 5 GHz as upper and lower limit and set single point simulation.
- Now the variables have to be enabled for optimization. By clicking twice on the coupler symbol the option window opens. Every variable has to be selected and enabled individually. Select a variable and click on Tune/Opt/Stat/DOE Setup... and switch to the Optimization tab. Set the status to Enabled and select the format $+/-\text{Delta \%}$ and the start value to 20. Repeat this procedure for all variables.
- Next, an optimization goal is necessary. For this purpose the block
Component Palette List > Optim/Stat/DOE > Goal

is required. Insert it on the page and double click the symbol. In the appearing window the following fields must be filled in:

1) **Expression**: Here, a mathematical expression must be inserted for which later a goal is defined. Insert initially \( \text{dB}(S(1,1)) \).

2) **Analysis**: Select a frequency range of the existing S-Parameter-Simulation blocks indicating the frequency range at which the goal must be reached. Optimize at exactly 5 GHz.

3) **Weight**: If multiple goals exist, they might be weighted. Keep the value of 1.

4) **Limit Lines**: The goal value can be set here as a maximum, minimum, or range. Consider what value should be obtained for \( \text{dB}(S(1,1)) \) at 5 GHz instead of the current value and how you might reach this.

- Insert an optimization:

Component Palette List > Optim/Stat/DOE > Optim

To change the settings you may double click the symbol. Choose a gradient optimization and confirm with [OK].

- Start now the optimization with the red-green arrow button. Several windows appear of which only the optimization window is of interest. There, the optimized values and the error values are displayed. In case of a successful optimization (error bar is green), the optimized values can be transferred to the Schematic Page by pressing the Update Design-Button. Thereby, it is enough to change the variables. If the optimization failed, the goals may not be reachable and should be checked.

- Close all windows of the optimization and start a new simulation with the updated parameters.

Plot the same S-parameters as before. Was the optimization of the input port and the isolated port successful? What values should the other S-parameters of the other two ports have?

If these show deviations to the expected values, think up another goal for those and add another goal to the schematic and repeat the optimization.

### 5.4 Amplifier

Finally, an amplifier circuit should be designed. At first, the amplifier on its own should be characterized:

- Create a new cell named \( \text{Amplifier1} \). The required amplifier can by inserted by going to:

**Insert** > **Component** > **Component Library** > **All Libraries**

and enter `sp_sms_CFY66-08_19920901` in the search field and insert the amplifier
in the schematic the same way you did with the coupler before.

- The amplifier should be inserted in a common-source circuit. Connect \textit{S-Parameter-Ports} to all ports that are not at constant potential. The source impedance should be $50 \, \Omega$ and the load $(200 + j150) \, \Omega$. Insert simulation components and simulate the amplifier at a frequency range of 2 GHz to 18 GHz.

Plot the amplitude of the transmission and reflection factor in dB and make a short sketch:

![Graph showing amplitude vs. frequency](image)

- Is this a matched amplifier network? What is the gain at 10 GHz?

Additionally, take a look at the input and output stability circles at 10 GHz. Therefore, an additional S-parameter simulation block at 10 GHz is required. Furthermore, the blocks: \texttt{Component Palette List > Simulation-S_Param > SS\text{\textup{t}}b\text{\textup{C}ir}} and \texttt{Component Palette List > Simulation-S_Param > LS\text{\textup{t}}b\text{\textup{C}ir}} which produce the stability circles of the input (S=source) and the output (L=load).

- Before starting the simulation, make sure that the output of the network is terminated with $50 \, \Omega$. Start the simulation and display the circles in a Smith Chart. Compare the results with your results from the preparation questions.

- Is the transistor unlimited stable? Why?

In the next step, the matching network from the preparation questions is build. Save the cell once normal and once under the name $\rightarrow$ \texttt{Amplifier2}. In the cell \texttt{Amplifier2} you can solve the next task.

- Create the two matching \textit{Circuits} from the lab preparation using ideal transmission
lines. Take the matching networks with shorter lines, respectively. The necessary transmission lines will be found in Component Palette List > TLines-Ideal > TLIN. The required parameters of the lines are the impedance $Z$, the electrical line length $E$ in degree and the associated frequency, here 10 GHz.

- Perform a simulation. Attention, the load is again $(200 + j150) \Omega$.

Now make a plot showing $S(1, 1)$ and $S(2, 1)$ of both the matched → Amplifier2 and unmatched amplifier → Amplifier1 circuits in the same plot. To do so, insert a rectangular plot. In the next window you can select the dataset in a drop-down menu. Select the correct datasets and add the required variables to the plot. Make a short sketch of the results:

![Graph 1](image1)

Repeat the procedure for $S(1, 2)$ in a second plot and make another sketch.

![Graph 2](image2)

What is the condition that must be met for matching and is this goal approximately achieved? Was the matching successful? How large is the gain at 10 GHz?
Switch back to the *Schematic-Page* and adjust the circuit such that you can analyze the input and output stability behavior. Start another simulation.

Generate the input and output stability circles and draw the results in the Smith Chart:

![Smith Chart](image)

### 5.5 Amplifier Noise Figure

The amplifier circuit should be characterized regarding its noise figure and the remaining mismatch:

- Save the cell once under the old name and once under the name → *Amplifier3*.
- Enable for every S-Parameter block the *Noise Simulation* option. Add the block *Component Palette List > Simulation-S_Param > Option* and set Temp=16.85 and Tnorm=25.

In the following, several ADS functions are added to evaluate the noise figure and gain of the amplifier. Insert the components and describe shortly their function. A description of the behavior of a block can be found in its manual. Thereto, double click the symbol and press the **Help**-Button to open the Manual.

Make yourself familiar with the properties of the following components: *Component Palette List > Simulation-S_Param > ...*

**MaxGain:** 

---

Lab course RF Engineering 3: CAD (Linear Circuits) 27
5 Measuring Tasks

StabFact:

StabMeas:

- First, evaluate the stability in the chosen frequency range. Set the load resistance to 
  (200 + 150j) Ω and start a simulation.
- Plot the stability factors in a common plot. Make a sketch of the plot and mark the 
  different stability regions.

Next, the trade-off of noise figure and available gain should be evaluated. Disable the 2-10 GHz 
S-parameter simulations and start the simulation.

- First, you need to define equations in the Display Window. To insert a single equation 
  select [Eqn] in the left bar and insert the block. A window opens wherein you can edit 
  your equation on the left side. On the right side is a list of variables already defined by 
  the program, e.g. by components you inserted on the Schematic Page.
- The first task is to determine and plot circles with constant noise figure in the Smith 
  Chart. Define the variable NFValue2 which should describe the minimum noise figure 
  NFmin (list on the right side). Since the minimum noise figure is only a single point in 
  the Smith Chart you should add an offset of 0.002 dB to this value to obtain a small 
  circle around the minimum noise figure later in the plot. The equation should be as 
  follows (you have to replace all underlined parameters!!):

  \[ NFValue2 = NFmin + Offset \]

Create NFValue2 and confirm with [Ok].
- To create multiple circles with noise figure spacing of 0.2 dB, a second equation is required 
  which calls the function ns_circle() that calculates the circles.

  \[ My\_Noise\_Circle = ns\_circle(nf2, NFmin, Sopt, Rn, numOfPts) \]

Its transfer parameters are in detail:
nf2: Array with desired noise figures; Beginning with NFValue2 define 4 circles with noise figure spacing 0.2 dB: \( \text{nf2}=\text{NFValue2}+[0::3] \times 0.2 \).

NFmin, Sopt: Minimum noise figure and source reflection coefficient; These variables are automatically generated through noise analysis during simulation and should be adopted here.

Rn: Equivalent normalized noise resistance; This variable is automatically generated through noise analysis during simulation, too, but has to be normalized to 50 Ω.

numOfPts: Number of sampling points per circle: Set this value to 51.

- Furthermore, multiple gain circles should be generated. The procedure for these circles is almost identical to the one of the noise figure. Define the variable GAvalue for the maximum gain MaxGain1 circle and add an offset of 0.002 dB:

  \[ \text{GAValue} = \text{MaxGain1} + \text{Offset} \]

- Likewise, create four gain circles with the second variable My_Gain_Circle that calls the function ga_circle() to calculate the gain circles:

  \[ \text{My_Gain_Circle} = \text{ga_circle}(S, \text{gain}, \text{numOfPts}) \]

Its transfer parameters are in detail:

S: S-Parameter matrix: \( S \).

gain: Gain array with desired values in dB; beginning with GAvalue, generate four gain circles with spacing 1 dB: \( \text{gain}=\text{GAvalue}+[0::3] \times 1 \).

numOfPts: Number of sampling points per circle: Set this value to 51.

- Create a Smith Chart with your generated circles. In the drop-down menu choose Equations and your variables will be displayed in the left column. Add My_Noise_Circle and My_Gain_Circle to the Traces-List. From the dataset Amplifier3 choose the stability circles as well. Switch to the tab Plot Options. There, disable Auto Scale and set Max to 1, in fact, only reflection coefficients smaller than 1 can be reached.

Create the plot and make a sketch. Consider which impedance region you should prefer considering stability, noise figure and achievable gain. Hatch this region in your draft.
### 5.6 Additional Task: Coupler In Momentum

The planar circuit *Coupler_2* is now transferred to a layout.

- Open again → *Coupler_2* and choose in the menu: **Layout > Generate/Update Layout**. Close the following windows with [Ok] until the main window with the layout opens.
- Terminate all ports of the coupler with a *Pin*.

Next, the properties of the substrate and conductor of the planar circuit are defined.

- Select in the menu **EM > Simulation Setup**
- Select in the bar left *Substrate* and click [New] on the right hand side to create and edit a new substrate. Select, as given in the task, *RT Duroid 6010* and close the window.
- Select the conductor in the profile. On the right hand side you can edit now its properties. Click on **...** next to *Material* and in the following window on **Add from Database**. Select *copper* and close both windows. In the substrate window, you can now select *copper* in the drop-down menu next to *Material*. Additionally, select *Expand the substrate* below and set the thickness to 17 microns.
- Next, select the substrate in the profile. On the right hand side, click on **...** next to *Material* and in the following window again on **Add from Database**.
Select Rogers\_RT\_Duroid6010 and close both windows. In the substrate window, set the material to Rogers\_RT\_Duroid6010 in the drop-down menu and the thickness to 0.635 mm.

- Finally, select the bottom layer in the profile. Change the thickness to 17 microns and keep the other default properties.
- Save and close the substrate properties.

In the following, the simulation parameters are edited.

- Select Frequency Plan. Set the frequency range to 3 GHz to 10 GHz with 50 samples (Type=adaptive). Additionally, insert with Add explicitly the frequency 5 GHz (Type=Single).
- Select Options in the bar left and switch to the Mesh tab. Set Cells/Wavelength to 40 and enable Edge mesh (auto) and Transmission line mesh (50 cells).
- Switch to Resources in the left bar and set Number of threads to 4 cores.
- Start the simulation with Simulate. The processing may take some time.

If the simulation finished, the visualization window can be opened: EM > Post-Processing > Visualization

- Select the tab Sol. Setup (Please note that there are tabs located on the top as well as on the bottom of the window!) and choose Port 1 and the frequency 5 GHz.
- Switch to the tab Plot Properties and enable dB Scale and Animate. The animation on the right side should start. On the bottom of the visualization, you may adjust the color scaling if necessary.
Fig. 9: Momentum simulation of coupler 2.
• Close ADS, log out, close all Windows in the room you were working in and ask the tutor to sign the Performance of this lab.
Fig. 10: Parameter $Z_0$ (Wellenwiderstand, characteristic impedance), $\varepsilon_{\text{eff}}$ of the microstrip line on different substrates of technical interest: Teflon ($\varepsilon_r=2.1$), Polyolefin ($\varepsilon_r=2.3$), glass fiber enforced Teflon ($\varepsilon_r=2.5$), Quartz glass (fused quartz: $\varepsilon_r=3.78$), $\text{Al}_2\text{O}_3$ ceramics ($\varepsilon_r=9.8$ or 10), semi-isolating silicium ($\varepsilon_r=11.9$), semi-isolating gallium arsenide ($\varepsilon_r=12.9$) and non-magnetic ferrite ($\varepsilon_r=16$) for $t=0$ using the Method of Lines.
### B Rogers 6010 Laminates

**Fig. 11:** RT/duriod 6006/6010LM High Frequency Laminates [9].

<table>
<thead>
<tr>
<th>Property</th>
<th>Typical Value</th>
<th>Direction</th>
<th>Units [1]</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Dielectric Constant, k, Prior]</td>
<td>6.30 – 6.35</td>
<td></td>
<td></td>
<td>10 GHz – 20 GHz</td>
</tr>
<tr>
<td>[Dielectric Constant, k, Design]</td>
<td>6.45</td>
<td></td>
<td></td>
<td>10 GHz – 40 GHz</td>
</tr>
<tr>
<td>Dissipation Factor, tan δ</td>
<td>0.0027</td>
<td></td>
<td></td>
<td>1 GHz – 18 GHz</td>
</tr>
<tr>
<td>Thermal Coefficient of α_s</td>
<td>410</td>
<td>ppm/°C</td>
<td></td>
<td>50 to 170°C</td>
</tr>
<tr>
<td>Surface Resistivity</td>
<td>75 x 10^9</td>
<td>mohms</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Volume Resistivity</td>
<td>2.5 x 10^12</td>
<td>mohms</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Young’s Modulus</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Young’s modulus</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ultimate stress</td>
<td>17.0 (6.8)</td>
<td>N/mm^2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ultimate strain</td>
<td>13 (1.9)</td>
<td>%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ultimate strain</td>
<td>1210 (13)</td>
<td>N/mm^2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>% deformation</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Moisture absorption</td>
<td>0.08</td>
<td>%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Density</td>
<td>3.1</td>
<td>g/cm^3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thermal Conductivity</td>
<td>0.46</td>
<td>W/m°C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thermal expansion</td>
<td>94</td>
<td>ppm/°C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Coefficient of α</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>h (in)</td>
<td>500</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Specific heat</td>
<td>0.17</td>
<td>J/g°C</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Copper per</td>
<td>14.3 (2.5)</td>
<td>%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lead-Free Process</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Compatibility of RT/duriod</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**STANDARD PANEL SIZE:**

- **STANDARD COPPER CLADDING:**

- 0.006" (0.152mm)
- 0.010" (0.254mm)
- 0.015" (0.381mm)
- 0.020" (0.508mm)
- 0.025" (0.635mm)
- 0.030" (0.762mm)
- 0.070" (1.800mm)
- 0.100" (2.540mm)

Non-standard thicknesses are available for 0.004" (0.102mm), 0.007" (0.178mm), and 0.008" (0.203mm). Copper cladding is available on these thicknesses. Contact Rogers for further details.

### Features

- High dielectric constant for circuit size reduction.
- Low loss, ideal for operating at X-band or below.
- Low Z-axis expansion for RT/duriod 6010LM, reduces effects of moisture on electrical loss.
- Tight ε and thickness control for repeatable circuit performance.

### Some Typical Applications

- Patch Antennas
- Satellite Communications Systems
- Power Amplifiers
- Aircraft Collision Avoidance Systems
- Ground Radar Warning Systems

RT/duriod 6006, RT/duriod 6010LM Laminates

©2013 Rogers Corporation. Printed in U.S.A. All rights reserved. Revised 1005 Q1F013 Publication: 93-101
C Scattering Parameters of the Transistor CFY 66

Streuparameter des Siemens CFY66-08 Hmt: $V_{ds}=2V$ $I_d=10mA$

<table>
<thead>
<tr>
<th>freq</th>
<th>$S(1,1)$</th>
<th>$S(2,1)$</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.000GHz</td>
<td>0.735 – j0.617</td>
<td>-3.398 + j2.469</td>
</tr>
<tr>
<td>3.000GHz</td>
<td>0.488 – j0.780</td>
<td>-2.455 + j3.258</td>
</tr>
<tr>
<td>4.000GHz</td>
<td>0.210 – j0.844</td>
<td>-1.390 + j3.622</td>
</tr>
<tr>
<td>5.000GHz</td>
<td>-0.057 – j0.818</td>
<td>-0.256 + j3.661</td>
</tr>
<tr>
<td>6.000GHz</td>
<td>-0.301 – j0.709</td>
<td>0.662 + j3.405</td>
</tr>
<tr>
<td>7.000GHz</td>
<td>-0.472 – j0.543</td>
<td>1.489 + j2.923</td>
</tr>
<tr>
<td>8.000GHz</td>
<td>-0.585 – j0.366</td>
<td>2.048 + j2.274</td>
</tr>
<tr>
<td>9.000GHz</td>
<td>-0.641 – j0.196</td>
<td>2.338 + j1.699</td>
</tr>
<tr>
<td>10.000GHz</td>
<td>-0.650 – j0.022</td>
<td>2.531 + j1.075</td>
</tr>
<tr>
<td>11.000GHz</td>
<td>-0.614 + j0.142</td>
<td>2.590 + j0.457</td>
</tr>
<tr>
<td>12.000GHz</td>
<td>-0.547 + j0.291</td>
<td>2.517 – j0.132</td>
</tr>
<tr>
<td>13.000GHz</td>
<td>-0.446 + j0.416</td>
<td>2.318 – j0.621</td>
</tr>
<tr>
<td>14.000GHz</td>
<td>-0.323 + j0.517</td>
<td>2.084 – j1.108</td>
</tr>
<tr>
<td>15.000GHz</td>
<td>-0.178 + j0.583</td>
<td>1.728 – j1.502</td>
</tr>
<tr>
<td>16.000GHz</td>
<td>-0.032 + j0.619</td>
<td>1.293 – j1.780</td>
</tr>
<tr>
<td>17.000GHz</td>
<td>0.109 + j0.620</td>
<td>0.832 – j1.961</td>
</tr>
<tr>
<td>18.000GHz</td>
<td>0.226 + j0.588</td>
<td>0.437 – j2.054</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>freq</th>
<th>$S(1,2)$</th>
<th>$S(2,2)$</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.000GHz</td>
<td>0.022 + j0.040</td>
<td>0.577 – j0.320</td>
</tr>
<tr>
<td>3.000GHz</td>
<td>0.041 + j0.048</td>
<td>0.468 – j0.422</td>
</tr>
<tr>
<td>4.000GHz</td>
<td>0.062 + j0.047</td>
<td>0.338 – j0.483</td>
</tr>
<tr>
<td>5.000GHz</td>
<td>0.082 + j0.038</td>
<td>0.197 – j0.513</td>
</tr>
<tr>
<td>6.000GHz</td>
<td>0.097 + j0.024</td>
<td>0.072 – j0.515</td>
</tr>
<tr>
<td>7.000GHz</td>
<td>0.106 + j0.006</td>
<td>-0.042 – j0.478</td>
</tr>
<tr>
<td>8.000GHz</td>
<td>0.107 – j0.013</td>
<td>-0.121 – j0.423</td>
</tr>
<tr>
<td>9.000GHz</td>
<td>0.106 – j0.028</td>
<td>-0.184 – j0.377</td>
</tr>
<tr>
<td>10.000GHz</td>
<td>0.103 – j0.044</td>
<td>-0.229 – j0.328</td>
</tr>
<tr>
<td>11.000GHz</td>
<td>0.095 – j0.057</td>
<td>-0.257 – j0.266</td>
</tr>
<tr>
<td>12.000GHz</td>
<td>0.086 – j0.070</td>
<td>-0.287 – j0.201</td>
</tr>
<tr>
<td>13.000GHz</td>
<td>0.075 – j0.080</td>
<td>-0.308 – j0.144</td>
</tr>
<tr>
<td>14.000GHz</td>
<td>0.063 – j0.090</td>
<td>-0.308 – j0.088</td>
</tr>
<tr>
<td>15.000GHz</td>
<td>0.049 – j0.096</td>
<td>-0.289 – j0.020</td>
</tr>
<tr>
<td>16.000GHz</td>
<td>0.033 – j0.101</td>
<td>-0.277 + j0.044</td>
</tr>
<tr>
<td>17.000GHz</td>
<td>0.018 – j0.103</td>
<td>-0.265 + j0.091</td>
</tr>
<tr>
<td>18.000GHz</td>
<td>0.004 – j0.103</td>
<td>-0.243 + j0.118</td>
</tr>
</tbody>
</table>

Fig. 12: Measured scattering parameters of the transistor CFY 66 (Siemens) with $V_{ds}=2V$ and $I_d=10mA$, normalizing impedance $50\Omega$. [8]
D.1 ADS TLInes-Ideal MLIN Overview

Fig. 13: MLIN Symbol Help [7].
D.2 ADS TLines-Ideal MTEE Overview

Symbol

Illustration

Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Units</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subst</td>
<td>Substrate instance name</td>
<td>None</td>
<td>MSub1</td>
</tr>
<tr>
<td>W1</td>
<td>Conductor width at pin 1</td>
<td>mil</td>
<td>25.0</td>
</tr>
<tr>
<td>W2</td>
<td>Conductor width at pin 2</td>
<td>mil</td>
<td>25.0</td>
</tr>
<tr>
<td>W3</td>
<td>Conductor width at pin 3</td>
<td>mil</td>
<td>50.0</td>
</tr>
<tr>
<td>Temp</td>
<td>Physical temperature (see Notes)</td>
<td>°C</td>
<td>None</td>
</tr>
</tbody>
</table>

Range of Usage

\[ W_1 + W_3 \leq 0.5 \lambda \]
\[ W_2 + W_3 \leq 0.5 \lambda \]
\[ 0.10 \times H \leq W_1 \leq 10 \times H \]
\[ 0.10 \times H \leq W_2 \leq 10 \times H \]
\[ 0.10 \times H \leq W_3 \leq 10 \times H \]
\[ \varepsilon_r \leq 128 \]

where
\[ \varepsilon_r = \text{dielectric constant (from associated Subst)} \]
\[ H = \text{substrate thickness (from associated Subst)} \]
\[ \lambda = \text{wavelength in the dielectric} \]

Fig. 14: MTEE Symbol Help [7].
D.3 ADS TLines-Ideal MSUB Overview

Fig. 15: MSUB Symbol Help [1].
E ADS – Windows Overview

Fig. 16: ADS Main Window, Project Folder, Library View [6 p. 5].

Fig. 17: Schematic Window Toolbar [6 p. 10].
Fig. 18: Schematic Window Utilisation [6] p. 11.
Fig. 19: Data Display Window Utilisation [6, p. 20].
**Default ADS Simulation**

<table>
<thead>
<tr>
<th>Description</th>
<th>Typical Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC</td>
<td>All RF/Analog designs</td>
</tr>
<tr>
<td>Fundamental to all RF/Analog</td>
<td></td>
</tr>
<tr>
<td>simulations. It performs a topology</td>
<td></td>
</tr>
<tr>
<td>check and an analysis of the DC</td>
<td></td>
</tr>
<tr>
<td>operating point.</td>
<td></td>
</tr>
<tr>
<td>AC</td>
<td>Filter</td>
</tr>
<tr>
<td>Obtains small-signal transfer</td>
<td>Amplifier</td>
</tr>
<tr>
<td>parameters like voltage gain,</td>
<td></td>
</tr>
<tr>
<td>current gain, and linear noise</td>
<td></td>
</tr>
<tr>
<td>voltage and currents.</td>
<td></td>
</tr>
<tr>
<td>S-Parameter</td>
<td>Filter</td>
</tr>
<tr>
<td>Provides linear S-parameter, linear</td>
<td>Oscillator</td>
</tr>
<tr>
<td>noise parameters, transimpedance,</td>
<td>Amplifier</td>
</tr>
<tr>
<td>and transadmittance. Can be used</td>
<td></td>
</tr>
<tr>
<td>to achieve many goals of the AC</td>
<td></td>
</tr>
<tr>
<td>simulator.</td>
<td></td>
</tr>
<tr>
<td>Harmonic Balance</td>
<td>Mixer</td>
</tr>
<tr>
<td>Uses nonlinear harmonic-balance</td>
<td>Oscillator</td>
</tr>
<tr>
<td>techniques to find the steady-state</td>
<td>Power amplifier</td>
</tr>
<tr>
<td>solution in the frequency domain.</td>
<td>Transceiver</td>
</tr>
<tr>
<td>Circuit Envelope</td>
<td></td>
</tr>
<tr>
<td>Uses a combination of frequency-</td>
<td>Mixer</td>
</tr>
<tr>
<td>and time-domain analysis techniques</td>
<td>Oscillator</td>
</tr>
<tr>
<td>to yield a fast and complete</td>
<td>Power amplifier</td>
</tr>
<tr>
<td>analysis of complex signals such as</td>
<td>Transceiver</td>
</tr>
<tr>
<td>digitally modulated RF signals.</td>
<td>Phase-locked loop</td>
</tr>
<tr>
<td>LSSEP</td>
<td>Power amplifier</td>
</tr>
<tr>
<td>Performs large-signal S-parameter</td>
<td></td>
</tr>
<tr>
<td>analyses to represent nonlinear</td>
<td></td>
</tr>
<tr>
<td>behavior. The accompanying P2D</td>
<td></td>
</tr>
<tr>
<td>simulator can be used to speed up</td>
<td></td>
</tr>
<tr>
<td>subsequent analyses.</td>
<td></td>
</tr>
<tr>
<td>Transient/Convolution</td>
<td>Mixer</td>
</tr>
<tr>
<td>Solves a nonlinear circuit entirely</td>
<td>Power amplifier</td>
</tr>
<tr>
<td>in the time domain using simplified</td>
<td>Switching circuits</td>
</tr>
<tr>
<td>models to account for the</td>
<td></td>
</tr>
<tr>
<td>frequency-dependent behavior of</td>
<td></td>
</tr>
<tr>
<td>distributed elements.</td>
<td></td>
</tr>
<tr>
<td>Ptolemy</td>
<td>Digital Circuits</td>
</tr>
<tr>
<td>Uses Digital Domain for simulation.</td>
<td>DSP</td>
</tr>
<tr>
<td>Momentum</td>
<td>Layouts</td>
</tr>
<tr>
<td>Electromagnetic Simulation of</td>
<td></td>
</tr>
<tr>
<td>planar structures</td>
<td></td>
</tr>
<tr>
<td>FEM</td>
<td>Filters, Antennas, Couplers,</td>
</tr>
<tr>
<td>Full 3D Finite-Element Electromagnetic</td>
<td>Multilayer</td>
</tr>
<tr>
<td>Simulation of 3-dimensional</td>
<td></td>
</tr>
<tr>
<td>structures</td>
<td></td>
</tr>
</tbody>
</table>

Fig. 20: Default Simulations with Applications [6 p. 26].
GADS Default Constants, System Units and Prefixes

Built-in Constants

The following constants can be used in expressions:

<table>
<thead>
<tr>
<th>Constant</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>PI</td>
<td>Euler’s constant</td>
<td>3.1415926535898</td>
</tr>
<tr>
<td>e</td>
<td>Natural log of 10</td>
<td>2.718281822</td>
</tr>
<tr>
<td>ln10</td>
<td>Boltzman’s constant</td>
<td>1.380658e-23 J/deg.K</td>
</tr>
<tr>
<td>qelectron</td>
<td>Electron charge</td>
<td>1.60217733e+19 C</td>
</tr>
<tr>
<td>plank</td>
<td>Plank’s constant</td>
<td>6.6260755e-34 J·sec</td>
</tr>
<tr>
<td>c0</td>
<td>Speed of light in free space</td>
<td>2.99792e+8 m/sec</td>
</tr>
<tr>
<td>e0</td>
<td>Permittivity of free space</td>
<td>8.85418e-12 F/m</td>
</tr>
<tr>
<td>u0</td>
<td>Permeability of free space</td>
<td>12.5664e-7 H/m</td>
</tr>
<tr>
<td>i j</td>
<td>sqrt(-1)</td>
<td>1 j</td>
</tr>
</tbody>
</table>

System Units

<table>
<thead>
<tr>
<th>Type</th>
<th>Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angle</td>
<td>Deg</td>
</tr>
<tr>
<td>Capacitance</td>
<td>F</td>
</tr>
<tr>
<td>Conductance</td>
<td>Sie</td>
</tr>
<tr>
<td>Current</td>
<td>A</td>
</tr>
<tr>
<td>Frequency</td>
<td>Hz</td>
</tr>
<tr>
<td>Inductance</td>
<td>H</td>
</tr>
<tr>
<td>Length</td>
<td>m, inch, mil</td>
</tr>
<tr>
<td>Linear Power</td>
<td>W</td>
</tr>
<tr>
<td>Power (dBm)</td>
<td>dBm</td>
</tr>
<tr>
<td>Resistance</td>
<td>Ohm</td>
</tr>
<tr>
<td>Time</td>
<td>sec</td>
</tr>
<tr>
<td>Voltage</td>
<td>V</td>
</tr>
</tbody>
</table>

System Prefixes

<table>
<thead>
<tr>
<th>Factor</th>
<th>Meaning</th>
<th>System Prefix</th>
</tr>
</thead>
<tbody>
<tr>
<td>10e12</td>
<td>Tera</td>
<td>t or T</td>
</tr>
<tr>
<td>10e9</td>
<td>Giga</td>
<td>g or G</td>
</tr>
<tr>
<td>10e6</td>
<td>Mega</td>
<td>M (only)</td>
</tr>
<tr>
<td>10e3</td>
<td>Kilo</td>
<td>k or K</td>
</tr>
<tr>
<td>10e-2</td>
<td>Centi</td>
<td>c or C</td>
</tr>
<tr>
<td>10e-3</td>
<td>Milli</td>
<td>m (only)</td>
</tr>
<tr>
<td>10e-6</td>
<td>Micro</td>
<td>u or U</td>
</tr>
<tr>
<td>10e-9</td>
<td>Nano</td>
<td>n or N</td>
</tr>
<tr>
<td>10e-12</td>
<td>Pico</td>
<td>p or P</td>
</tr>
<tr>
<td>10e-15</td>
<td>Femto</td>
<td>f or F</td>
</tr>
</tbody>
</table>

1) The prefixes m, M and f (or F) must be followed by a unit description (MHz, fF, mOhm, MOhm) or they will be ignored.

Fig. 21: Built-in System Constants, Units, and Prefixes [6, p. 51].

Lab course RF Engineering 3: CAD (Linear Circuits)
**H Default Keyboard Hot-Keys**

Please note, that the hot keys do **not** work properly, if one of the keys caps-lock, num-lock, or scroll-lock are active.

<table>
<thead>
<tr>
<th>Command</th>
<th>Hot-Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Design</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open Design</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save Design</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Print Design</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Close Window</td>
<td>Ctrl+F4</td>
</tr>
<tr>
<td>Edit Undo</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>End Command</td>
<td>ESC</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Delete</td>
<td>Del</td>
</tr>
<tr>
<td>Rotate</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Mirror About X</td>
<td>Shift+X</td>
</tr>
<tr>
<td>Mirror About Y</td>
<td>Shift+Y</td>
</tr>
<tr>
<td>Move</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>Move Component Text</td>
<td>F5</td>
</tr>
<tr>
<td>Select all</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>View All</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Restore Last View</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Zoom In X2</td>
<td>Add (+)</td>
</tr>
<tr>
<td>Zoom Out X2</td>
<td>Sub (-)</td>
</tr>
<tr>
<td>Clear Highlighting</td>
<td>F8</td>
</tr>
<tr>
<td>Grid Display</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Insert Wire</td>
<td>Ctrl+W</td>
</tr>
<tr>
<td>Insert Text</td>
<td>Ctrl+Shift+T</td>
</tr>
<tr>
<td>Insert Polygon</td>
<td>Ctrl+Shift+P</td>
</tr>
<tr>
<td>Insert Rectangle</td>
<td>Ctrl+Shift+R</td>
</tr>
<tr>
<td>Undo Vertex</td>
<td>Shift+Z</td>
</tr>
<tr>
<td>Snap Enabled (toggle)</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Window Schematic</td>
<td>Ctrl+Shift+S</td>
</tr>
<tr>
<td>Window Layout</td>
<td>Ctrl+Shift+L</td>
</tr>
<tr>
<td>Simulate</td>
<td>F7</td>
</tr>
<tr>
<td>Help Whats this</td>
<td>Shift+F1</td>
</tr>
<tr>
<td>Help Topics and Index</td>
<td>F1</td>
</tr>
</tbody>
</table>

Fig. 22: ADS hotkeys [6, p. 50]
H Default Keyboard Hot-Keys